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Introduction 
 

 Welcome to the exciting world of personal map creation!  With this 
software you will be able to create new maps as well as modify existing maps for 
your facility.  Exactly what your map will end up looking like is entirely up to your 
creativity.  This manual will walk you through the basic functions of the Designer 
program and custom bitmap creation; however, learning to utilize these functions 
in conjunction with each other takes some time and practice.   
 

We recommend that you make a copy of your map prior to making any 
adjustments.  This will give you something to fall back on if you get the map 
jumbled while you are making changes.   

 
We have found that the most efficient way to learn this program is to 

actually try out the functions as you are reading through the manual.  This will 
give you an opportunity to see the functions in action, as well as give you a little 
bit of initial practice.  The more you practice that you get, the more confident you 
will be about utilizing this program to make the necessary, or desired, changes to 
your facility.  Let’s get started… 
 
 
 
Buttons 
 
Let’s get a general overview of the buttons you will be using to manipulate the 
different components of this program.  The following list has a picture of what the 
button looks like with a description to the right of it.  These descriptions will be 
elaborated upon later as we get into their actual use. 
 
This is what the toolbar looks like at the top of the screen:  
 

 
 
 
Here is a closer view of the buttons you will be using:  
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Quick Reference Sheet 
 
 
Button Description 
 

 ----------- Creates a new map file 
 ----------- Opens an existing map file 
 ----------- Saves the current map being modified 

 ----------- Prints the current map 

 ----------- Adds units onto the map 
 ----------- Deletes units, bitmaps, and text items from the map 

 ----------- Shows list of units on the map and will allow you to relocate them 

 ----------- Aligns the left side of selected objects to each other 

 ----------- Aligns the right side of selected objects to each other 
 ------------ Aligns the top of selected objects to each other 

 ------------ Aligns the bottom of selected objects to each other 

 ----------- Horizontally centers selected objects to each other 

 ----------- Vertically spaces objects 

 ----------- Horizontally spaces objects 
 ----------- Horizontally stacks objects next to each other 

 ----------- Vertically stacks objects next to each other 

 ----------- Diagonally stacks objects next to each other 

 ----------- Vertically stacks objects in reverse order next to each other 

 ---------- Horizontally stacks objects in reverse order next to each other 

 ----------- Groups selected objects together 

 ----------- Disassociates grouped objects 

 ----------- Turns selected units 90° 

 ----------- Turns selected units a specific number of degrees 

 ---------- Adjusts the size and the direction that unit numbers are displayed 
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Basic Functionality 
 
DATA - The first thing to understand about the Designer program is that it 
operates interactively with Storage Commander.  Designer reads the data path in 
Storage Commander to find the unit information it displays.  Any changes in 
Storage Commander are immediately reflected in Designer. 
 
The unit data that Designer uses is being read from the same place that Storage 
Commander reads the data, but the map (which holds location data) is being 
opened from wherever you have saved it.  This does not have to be the same 
place as the data to be able to work on the map.  You will, however, need to save 
the map in the same place as the data to be able to access it through Storage 
Commander.  The map file contains the location of the top left corner of each 
unit, bitmap, and text object that has been added.  How big each of these items 
is displayed has to do with information within the objects themselves. 
 
NEW MAPS – To create a new map, open up the Designer program.  Click on 
the New Map button .  The screen will be blank white.  It is ready for you to 
start adding units, bitmaps, and text items.  It will not display any units until you 
add them to the map. 
 
MODIFYING CURRENT MAPS – If you do not want to start from scratch, you 
can modify the map that is currently running in Storage Commander.  To do this, 
you will need to click on the Open File button .  This will bring up the Open 
window so that you can browse for an existing map.  By default, your current 
map is located on your C:\ drive inside the Empower\Storage Commander folder.  
We recommend that you save this file somewhere else before working on it for 
the very first time.  To do this, open up your default map, then click File Save 
As… and select a different folder to direct Designer to save the file into this new 
location.  Here I am saving the file on my C:\ drive in the Current Sites\Sample 
folder. 
 
SAVING MAPS – 
It is very important 
to understand 
where you are 
saving a map.  If 
you have used the 
directions for 
modifying an 
existing map, then 
the Save button 
will save the map 
wherever you 
opened it at, or if 
you used the Save As… button, it will save wherever you told it to save at.  If you 
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used the new map directions, then you will need to specify the location you want 
this map to save at the first time you click on the Save button .  After this 
initial save, all future saves will continue to automatically go to this same location.  
 
You will want to save your map at various intervals as you are working on 
it.  Every so often, if you want to keep everything you have done to it, then 
click on the Save button.  If you do not want the changes you have made to 
take effect, then close the Designer program without saving.  This will 
cause the map file to remain how it was when you last saved it. 
 
 
 
OBJECTS 
 
DEFINING AN OBJECT- So what is an object?  It is not entirely necessary to 
understand the definition of an object from a programming standpoint to utilize 
this program.  An object is a single item that the computer uses to define things.  
An object can be anything; in our case, it is any unit, bitmap, or text item.  It can 
also be a group of units, bitmaps, and text items.  Each of these is an object with 
specific properties regarding its size, color, etc. that the map file will display when 
it paints them on.  This will become more understandable as you begin to use the 
program and see these properties at work. 
 
SELECTING OBJECTS - To be able to make any changes to any of the objects, 
you must select it so the program knows that the changes you are making are 
going to be applied to that particular object or objects.  When an object is 
selected, it will get a dark border around it with 8 tiny nodes along its edges; one 
at each corner and one in the middle of each side.   
 

 
 
When working with a bitmap, these nodes will allow you to resize it by simply 
holding the left mouse button down on the desired node as you drag it to the 
appropriate position. 
 
Multiple objects can be selected by holding down the shift key as you left click on 
the objects.  When selecting multiple objects, the order that you select them can 
have a bearing on what happens when you make changes.  If you are stacking a 
bunch of units together, they will stack in the same order that you selected the 
units.  A reverse stack will stack in the reverse order that you selected the units.  
When aligning multiple objects, they will align to whichever object was selected 
first.  It is important to always know the order that you selected multiple objects.  
The “Master Unit” is always the first unit selected. 
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GROUPING / UNGROUPING OBJECTS – It is useful to know how to group and 
ungroup the objects you will be working with.  To group objects together, select 
the objects, using the multiple object selection method, and click on the Group 

button .  When you have grouped multiple objects together, the program will 
treat them as though they were one single object.  You will be able to move this 
group around and all the items in the group will remain in their respective 
positions relative to each other.  This allows you to piece together your buildings 
anywhere on the map that you want to and then move the buildings into place 
later.   
 
When you are ready to access the objects on an individual basis again, you 

simply highlight, or select the group and click on the Ungroup button .  This 
will remove the relational bond between the individual items of the group so that 
the singular items can be manipulated apart from the others. 
 
NOTE: We recommend that you always ungroup before saving your map for use in Storage 
Commander.  This enhances the overall performance of the system. 
 
 
 
Adding 
 
Units – Adding units is the most fundamental function of your Designer program.  
Without the units on your map, there is no interactive capability in your map.  To 

add a unit, click on the Add Units button .  This will bring up the following 
screen: 
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You can select individual units, consecutive groups of units, or disjunctive groups 
of units.  To add one unit, highlight the unit you want to add using the left mouse 
button.  Then click on the Add button in the lower right of the screen.  If you want 
to add a consecutive group of units, highlight the first unit in the group.  Then, 
holding the Shift key down, left click on the last unit of the group.  This will 
highlight all the units in between your first and second click.  Now, click the Add 
button.  If you want to add multiple units that are not listed next to each other, 
hold the Ctrl key down while you left click on all the units that you want to add.  
This will highlight only the units that you click on.  Then, click on the Add button. 
 
The added units will appear in the upper left corner of the map, and will be 
stacked on top of each other.  This section may not be visible on your screen, 
depending on where you are working in the map, so you may need to scroll all 
the way up and all the way to the left.  Once they are added to the map, you can 
move them to whichever area you are working in. 
 
Bitmaps – How extravagant your map shows up is entirely reliant on how much 
effort you put into your bitmaps.  A number of standard bitmaps are included with 
this program and are located on your C:\ drive in the Empower\Storage 
Commander folder.  
 
To add a bitmap, click on the Add menu and then click on the Bitmap item: 
 

 
 

This will bring up the following screen: 
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You can select the bitmap that you want to add onto the map here by highlighting 
it and clicking on the Open button in the lower right.   
 
NOTE: This screen will automatically open up to the last folder you used, which should be your 
C:\Empower\Storage Commander folder. If not, you may need to click on the drop down menu, 
where it says Look in: at the top of the screen, to point it to the correct folder initially. 
 
Once you have added the bitmap, it will appear in the top left corner of your 
screen, no matter where you are on the map (unlike the units which appear in the 
upper left of your map, not your screen).  It may not be the correct size, so it will 
be essential to resize it according to how big you need it to be on your map.  This 
can be accomplished using the 8 nodes along its edges.  Simply hold the left 
mouse button down while you drag it to the appropriate size. 
 
Text – Adding text items is useful for putting labels on your map.  This is 
accomplished in a similar fashion as bitmaps.  Click on the Add menu and select 
the Text Item from the menu: 
 

 
 

This will open the following screen: 
 

 
 

Here, you will fill in what you want the text item to say.  You will also select if you 
want it to be bold, italicized, underlined, or white (the default is black text).  
Lastly, you will determine what size you want it to show up as.  Any of these 
properties can be changed by simply double left clicking on the text item at any 
time.  Once you click on the OK button, it will be added to the map in the upper 
left corner of your screen, like the bitmaps, no matter where you are on the map. 
 
NOTE: Because the text items are objects, they have the 8 nodes, but these are not used for 
resizing.  Only resize using the above properties screen. 
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Stacking 
 
Horizontal – Stacking is the process of placing objects (units, bitmaps, or text 
items) right next to each other.   
 

 
 

You can see that there is a unit, a bitmap, and a text item stacked next to each 
other here.  Each is an object, so each has 8 nodes.  You can stack any 
combination of objects.   
 
To do this, select the left most object, hold down the Shift key, and select the rest 
of the objects in the order that you want them to stack next to each other.  Now, 

click on the Horizontal Stack button .  The units that you selected will not 
change their up and down position, only their left and right position.  In this 

example, the Align Top button  to align the top of these objects to each other.  
We will discuss aligning objects later.  For now, just notice how the left and right 
sides touch each other.  This is the product of stacking. 
 
Vertical – Vertical stacking behaves the same way that horizontal stacking does, 
only up and down instead of left and right. 
 

 
 

In vertical stacks, the first object selected is going to be the top one and will not 
move.  Once you have selected the units you want to stack vertically in the order 

that you want them to be stacked, click on the Vertical Stack button .  In this 

example, the Align Center button  was used to provide the left and right 
movement.  The vertical stack will simply position the objects so that their top 
and bottoms are next to each other. 
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Reverse – Reverse stacks will cause the stack, whether horizontal  or 

vertical , to stack together in the reverse order that the objects were selected.  
This means that the last item selected does not move while every other selected 
object will stack to the right or down from this object in the reverse order of their 
selection. 
 
Diagonal – Diagonal stacking is very restricted in its use.  If you have units that 
are rotated, and we will go over rotations later, this will stack the units in the 
direction of their slant.  Also, because of how it functions, it will perform both the 

left align  and the vertical stack  at the same time.  For example: 
 
Select Units in Order: Click On : Rotate Units: Diagonal Stack: 

A1, A2, A3  ; 10 degrees  

1  

 

2  

 

 

Above are two ways that the Diagonal Stack button  can be used.  The first 

instance is using the Diagonal Stack button  as being equivalent to the 

Vertical Stack button  plus the Left Align button  at the same time.  This is 
its functionality on non-rotated units.  If the units are rotated, as in the second 

instance, then the Diagonal Stack button  will stack the selected units down 
and aligned to the left in the direction of the rotation. 
 
 
 
Spacing  
 
Non-Rotated Spacing - Spacing is a tool for creating uniform distances between 
objects across a predetermined area.  It can also be used to adjust the positions 
of rotated units that do not stack in the direction of their rotation.  Both Horizontal 

Spacing  and Vertical Spacing  work the same, so only vertical examples 
will be used.  They also operate off the same basic principal of the horizontal and 
vertical stacks, only they do not position the units right next to each other.   
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Begin by selecting the units you want to space out.  Then hold the left mouse 
button down as you drag the end unit to the desired distance that you want to 
span.  For example: 
 

Select Units: Desired Distance: Uniformly Spaced: 
A1, A2, A3 Click and drag A3  

 
  

 
Rotated Spacing – For situations like RV parking areas, spacing can help you 
fine tune the rotated parking spaces to be properly positioned.  For example: 
 

Select Units: Rotate Units: Space Units: 
RV1, RV2, RV3 ; 30 degrees  

 

  
 
NOTE: Notice the overlap of the units in the rotated RV spaces.  By using the above method for 
spacing, you can eliminate this overlap.  The same method for spacing is used in both examples. 
 
 
 
Alignment 
 
Vertical Alignment – Vertical alignment is separated into two different types; 

there is Top Alignment and there is Bottom Alignment .  The arrow on the 
button points in the direction that the alignment will occur.  If you want to align the 

objects along their top edge, click on the Top Align button .  If, on the other 
hand, you want the alignment to be across the bottom edge of the objects, click 

on the Bottom Align button . 
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For example: 
 

Select Units: Align Top: Align Bottom: 
C26, C27, C28, C29   

 

  

 
Horizontal – There are two types of horizontal alignment; there is Left Side 

Alignment  and there is Right Side Alignment .  These alignments work off 
the same principles of the vertical alignments. 
 
For example: 
 

Select Units: Left Side Alignment: Right Side Alignment: 
C26, C27, C28, C29   

   
 
Center Alignment – One more alignment button is available.  This is the Center 

Alignment button .  The arrow here point to the left and to the right to indicate 
that this button will center the object to each other.  As before, the first object 
selected will not move as the other objects center themselves on it. 
 
For example: 
 

Select Units: Align Center: 
C26, C27, C28, C29  
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Rotation 
 
90° Rotation – Units, and groups of units, can be flipped 90° at a time by using 

the Rotate 90° button .  This rotation will apply to all units selected.  I will use 
an example of multiple individual units being rotated and an example of grouped 
units being rotated. 
 
Individual Units Example: 
 
Select Units: Rotate: Rotate: Rotate: Rotate: 
A1, A2, A3 ; 1st click ; 2nd click ; 3rd click ; 4th click 

     
 
Grouped Units Example: 
 
Select Group: Rotate: Rotate: Rotate: Rotate: 

A1 – A4 ; 1st click ; 2nd click ; 3rd click ; 4th click 

  

 

 
 
Notice that in a group rotate, the units remain in position relative to each other.  
The rotation is always clockwise and the upper left corner remains constant 
during these rotations as well.  This kind of rotation can be very useful if you 
notice that you built a building upside down or something of that sort.   
 
Specific Angle Rotation – Specific angles will help you to make your unit layout 
as realistic as possible.  As seen earlier, utilizing this type of rotation can also 
orient your RV units correctly.  To do this, you will need to select the units want to 

rotate, and then click on the Specific Angle Rotation button .  When you click 
on this button, a new screen will pop up prompting you to enter the number of 
degrees that you want to rotate.  This entry can be either positive or negative 
numbers.  The axis for the rotation is the upper left corner of the unit. 
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For example: 
 

When you click on the Specific Angle Rotation button , the following screen 
will pop up: 
 

 
 

 
 
 
 

By typing in 30 to do a 30° rotation, my units go from this:  
 
 
 
 
 
 
 
 
to become this:  

 
 
 
 
 
 
 
 
 
If I entered -30 to do a -30°rotation, I would end up with this:  
 
 
 
 
 
NOTE: Rotations of either type can only be used on units.  Neither text nor bitmaps can be 
rotated. 
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Formatting 
 
Size of Unit Numbers – The size of the unit numbers can be controlled by the 

Font Selection button .  This brings up the following screen: 
 

 
 

Zero is the default, which is equivalent to 8 point font if the unit is large enough.  
You can specify the font size you want to use by selecting the units that you want 
to adjust and clicking on this button.  Then simply enter the size you want to use.  
Currently, the Designer program will try to find the largest font size that the unit 
will hold within its borders if the default entry is in use.  Here are examples of the 
most common font sizes relative to each other: 
 

Font Size: 4 Font Size: 5 Font Size: 6 Font Size: 7 Font Size: 8 

     
 
Direction of Unit Numbers – The unit number are not restricted to simply 
printing across the unit.  They can also be printed down the unit by selecting the 
Vertical Font checkbox in the Font Size screen: 
 

 
 
This will cause the unit number to print down the unit instead of across the unit.  
The following diagram demonstrates this difference: 
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NOTE: The font size screen can only be used on units.  It does not adjust the font size on text 
items. 
 
 
 
Duplicating 
 
Before getting started with any duplication, be sure to save your map as it 
already is so you can always close and reopen the map in case you are not 
pleased with the results of the duplication. 
 
Units – Duplicating units can be a major factor in the speed of your map 
creation.  When you are duplicating units you will need to specify what part of 
their unit number will change when the duplication takes place.  This is to prevent 
from having multiple units with the same name existing on the map at the same 
time.  
 
You can duplicate a single unit or grouped units at any given time.  Simply select 
the individual unit, or grouped units, and then click the right mouse button on 
them.  A menu will appear and you need to select the option to Duplicate.  This 
will cause the following screen to come up: 
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This is the screen for indicating how the unit number will change during 
duplication.  You can make changes on up to ten digits, with 1st being the left 
most digit.  The changes can be positive or negative adjustments.  Also, the 
number changer will handle alpha or numeric changes.  If it is an alpha digit (“B”) 
in the desired position, then changing it by 1 will make it a “C” and changing it by 
-1 will make it an “A”.  If it is a number then it will add or subtract according to the 
amount that you put into that field.  Here is an example: 
 

Starting with this group: 
 

 
 

And making a change of 1 to the first digit: 
 

 
 

I end up with this group: 
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There are a couple of things to note here.   
 
First, when the duplicated units show up, they are still trying to reference the 
units in the Storage Commander database, so if these units exist, they will show 
up in the size that they are in the database.  They are not necessarily the same 
size as the units they were duplicated from.   
 
Second, if the duplicated unit does not exist in the database, then the unit will 
show up as a white unit.  If you do not need these white units, then just highlight 
and delete them from the map.  If you do need them, then you will need to create 
the unit numbers in the Storage Commander database. 
 
Bitmaps and Texts – Duplicating bitmaps and text items are the same process.  
To duplicate these objects, simply select the desired object and right click on it.  
Then select Duplicate from the menu that appears.  A carbon copy of the 
selected object will appear overlapping the object it was created from. 
 
 
 
Unit List Locator 
 
Some operating systems will allow you to place units outside the boundary of the 
viewable map.  When this happens, your map will not display correctly in Storage 
Commander.  If you go back into the Designer, these units may have 
disappeared.  Actually, they have been assigned negative positioning numbers.  

By clicking on the Unit List button , you can adjust the horizontal and vertical 
positioning of the units that are not visible.  This will allow you to bring those units 
back into the viewable area so you can reposition them.  The numbers represent 
pixels from the left of the screen or from the top of the screen. 
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Appendix A 
 

Creating Customized Bitmaps 
 
 

Creating customized bitmaps is a fairly simple process.  All you need to do is 
create a brand new bitmap using Microsoft Paint, which is included in all the 
Windows operating systems.  You can get to it by clicking on the Start button and 
going to Programs > Accessories > Paint.  This will open up the Paint program 
where you will create your bitmaps for use in Designer.   
 

 
 
This is what the new bitmap screen looks like.  The first thing to do is to save it to 
the folder that you are building your map in.  Click on File > Save As… to open 
the following window: 
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Make sure that the “Save in:” field has the name of the folder where the map is 
located.  Then, give your bitmap a name and type it into the “File name:” field.  
Finally, change the “Save as type:” field to “256 Color Bitmap (*.bmp; *.dib)” so 
that it appears as follows: 
 

 
 

Now click on the Save button. 
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Now that you have a new bitmap file created, it is time to design your bitmap.  
Using all of the tools in this bitmap program, create whatever picture that you 
want to add to your map.  By playing around with this, you will be able to 
generate any conceivable image that you want to add. 
 
You can also pull bitmaps off the web, off a CD, or from friends.  Where you get 
your bitmaps or how you create them is of no real importance for the map.  The 
only thing you need to be concerned about is that the bitmap is saved as a 256 
Color Bitmap and that it is saved in the same folder as the map you are working 
on.  If both of these are taken care of, you will be able to add and use any bitmap 
that you choose.  If the bitmap is not saved this way you will get one of two errors 
when you try to add the bitmap: 
 
 
 
 
 

1. This error means 
that the bitmap is 
not in the same 
folder as the 

map.  To correct this, simply save the bitmap into the correct folder. 
 

 
 
 
 

2. This error means that the 
bitmap was saved as the 
wrong type.  The bitmap will 
still show up on your map in 

the Designer, but it will prevent your map from proper operation 
inside Storage Commander.  To correct this, simply save the bitmap 
as a 256 Color Bitmap. 

 
Now you know how to implement customized bitmaps into your map.  Have fun 
creating all your new images!! 
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Appendix B 
 

Standard Bitmaps 
 

The following is an alphabetical list of all the bitmaps that are included with the 
Designer software: 
 
 
 
arrow_bl arrow_br arrow_down arrow_left 

   
 

arrow_right arrow_tl arrow_tr arrow_up 

 
   

block_black block_blue block_brown block_green 

    
block_grey block_lavender block_orange block_purple 

    
block_red block_tan block_yellow bush 

    
compass diagonal_ll_2_tr diagonal_tl_2_lr door1 
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door2 door3 door4 door5 

    
door6 door7 door8 dumpster 

   

 
fence firehydrant fountain grass 

 

 
  

grass_corner_bl grass_corner_br grass_corner_tl grass_corner_tr 

    
grass_tri_bl grass_tri_br grass_tri_tl grass_tri_tr 

    
handicap hedge_horiz hedge_vert lift 

   
 

line_curve_bl line_curve_br line_curve_tl line_curve_tr 

    
line_horiz line_vert lock men 
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parking_horiz_l1 parking_horiz_l3 parking_horiz_r1 parking_horiz_r3 

 

 

 

 
parking_vert_b1 parking_vert_b3 parking_vert_t1 parking_vert_t3 

 
 

 
 

public_phone railroad_horiz railroad_vert road_corner_bl 

 

 

 
 

road_corner_bl road_corner_tl road_corner_tr road_dead_end 

   

 
road_horiz road_T_bot road_T_left road_T_right 
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road_T_top road_vert sc_logo 

 

  
stairs_corner_bl stairs_corner_br stairs_corner_tl stairs_corner_tr 

    
stairs_horiz_l stairs_horiz_r stairs_horiz_wrapL_bot stairs_horiz_wrapL_top

    
stairs_horiz_wrapR_bot stairs_horiz_wrapR_top stairs_vert_bot stairs_vert_top 

    
stairs_vert_wrapD_L stairs_vert_wrapD_R stairs_vert_wrapU_L stairs_vert_wrapU_R 

    
tree_evergreen tree_leafy tree_palm triangle_black_bl 

    

triangle_black_br triangle_black_tl triangle_black_tr women 

    
 


